## HBC 2106: FUNDAMENTALS OF COMPUTER SYSTEMS

1. Course outline .............................................................................................................. 2

4. CHAPTER 1: The history of computers ........................................................................ 3
   4.1. IT concepts .............................................................................................................. 3
   4.2. History of computers ............................................................................................... 4

8. CHAPTER 2: Computer Arithmetic .............................................................................. 8
   8.1. Number systems ..................................................................................................... 8
   8.2. Working with signed numbers ................................................................................ 16
   8.3. Character set encoding ASCII and EBCDIC ........................................................... 17

9. CHAPTER 3: Computer Hardware .............................................................................. 18
   9.1. Basic Computer Elements - Hardware & Software ............................................... 18
   9.2. Hardware Components ........................................................................................... 18
       9.2.1. Input .............................................................................................................. 19
       10.1.1. Output ......................................................................................................... 20
       11.1.1. Storage ........................................................................................................ 20
       11.1.2. Central Processing Unit ............................................................................... 21

12. CHAPTER 4: Computer Software ............................................................................. 22
    12.1. System Software .................................................................................................. 22
        12.1.1. Operating Systems ..................................................................................... 22
        12.1.2. Utilities ....................................................................................................... 24
        12.2. Application Programs ..................................................................................... 25

13. CHAPTER 5: Types of Computer Instruction Set Architecture .................................. 26
    13.1. RISC versus CISC processors ........................................................................... 26

14. CHAPTER 6: Ms Word ............................................................................................... 27
    14.1. Introduction to Ms Word ..................................................................................... 27
    74.1. Creating Resume and Cover letter ...................................................................... 48

75. CHAPTER 7: Ms Excel .............................................................................................. 48
    75.1. Introduction to Ms Excel ..................................................................................... 48
    75.2. Excel and Financial Analysis .............................................................................. 59

76. CHAPTER 8: Networking and Internet ..................................................................... 59
    76.1. Introduction to Internet ....................................................................................... 59

77. Data Security ............................................................................................................. 65
    77.1. Data Security ....................................................................................................... 65
1. Course outline

KIRINYAGA UNIVERSITY COLLEGE
YEAR 1 SEMESTER 1
BACHELOR OF COMMERCE
HBC 2109: FOUNDATION OF COMPUTER SYSTEMS

Instructor: Geoffrey Gitau
Email: gitaugk@gmail.com

Introduction/Teaching Methodology
The Course provides a fundamental understanding of computer fundamentals and computer applications with the course focus on the Microsoft Office Applications (Microsoft Word, Microsoft Excel and Microsoft PowerPoint). This is a theory and lab based course where students will learn these applications by working on class assignments in the lab after developing ICT fundamental concepts. Students will also be covering the basic concepts in Computer Hardware, Software, Operating Systems, Telecommunications, as well as the usage of the Internet and conversion of Microsoft file format into various other file format (PDF, etc.).

2. Prerequisite: There is no prerequisite for this course.

Course Outline
- Fundamentals of IT/IS Concepts
  Introduction to the basics of IT/IS, distinguishing data from information, digital vs analog systems, bits, bytes, word, data representation – binary, octal, decimal and hex, advantages of computers, staff in an IT department
- Components of computer: Hardware and software
  - Input, processor, output and storages; distinguishing: CPU, ROM, RAM, input/output, peripherals, and software, Inside the PC, computer storages (hard disks, optical disks and other media. Purchasing a computer and specifications or hardware requirements
- Computer software
  - system software and operating systems, utilities including translators (assemblers, interpreters and compilers)
- History of Computing: The Rise of the Personal Computer
• **Computer architecture:** CISC and RISC processors, parallel array design and processor generations,

• **Windows:** Getting Started: Topics: PC basics, booting, logon, shutdown, Distinguishing System Software, Windows desktop environment, Viruses protection and policies, Using MS

**Windows/File Management:** Topics: operating systems, GUI, desktop, hierarchical structure of files and folders, Windows Explorer, file pathnames, moving, copying, deleting, renaming files

• **Application Software**

• Word Processing using MS Word: Basics of word processing, spell checking, saving, retrieving documents, formatting, page setup, moving, copying text, bullets, lists, tables. Document format – Writing an academic research paper

• Spreadsheets using MS Excel: Introduction to spreadsheets, rows, columns, cells, formulas, constants, cell ranges, formatting cells, functions, charts, decision making

• Powerpoint Presentations using MS PowerPoint: Creating a presentation, templates, slide shows

• Internet and Email skills

**Reference**

http://office.microsoft.com

Department’s Research Document Formatting Guideline

3. **Assessment Plan**

<table>
<thead>
<tr>
<th>Component</th>
<th>Frequency</th>
<th>%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final Exam</td>
<td>1</td>
<td>70%</td>
</tr>
<tr>
<td>Continuous Assessment</td>
<td>2</td>
<td>30%</td>
</tr>
<tr>
<td>Individual assignment (CAT1) 10mks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAT (2) 10 marks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAT (2) 10 Marks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTAL</td>
<td></td>
<td>100%</td>
</tr>
</tbody>
</table>

4. **CHAPTER 1: The history of computers**

4.1. **IT concepts**

**Definition of a computer**

A computer is a programmable electronic device that accepts data input to process it using
some set of instructions (programs) so as to produce some output information.

**Components of a computer system**
A computer system comprises of two primary components - Hardware and software. Hardware refers to the computer physical parts which are further divided into input devices, the central processing unit (CPU), output devices, and storage devices. Software on the other hand is categorized into systems software and application software. System software are programs that are required by the computer in order to make it be ready for its functions. They include operating systems and utility programs. Operating systems are programs that are used to support basic computer operations from the time it is powered on until it is shut down. It functions as the platform on which a computer user runs all their user specific programs. Utility programs are variety of programs that can be added to a computer so as to extend functionality of the computer by creating additional functions not necessarily primary to the operating system but give enhanced user environment and some housekeeping functions. For example anti-virus, CD writing software, video player, calculator, etc.

Applications software refer to a variety of programs for user specific tasks. The choice of an application program depends on the type of user and what one wants to do. For example accounting packages, architectural programs, word processing programs, etc.

**Assignment:** Identify FIVE application programs that can used in a large wholesale business.

**Types of computers**
Computers can be categorized as follows;

- **Analog vs digital:** An analog computer is a form of computer that uses the continuously-changeable aspects of physical phenomena such as electrical, mechanical, or hydraulic quantities to model the problem being solved. In contrast, digital computers represent varying quantities of measurement using discrete values of two digits 0,1 called binary digits. Digital computers are the proper meaning of a computer today.

- **Dedicated (special purpose) vs general purpose computer:** A dedicated computer is a computing device that is designed by the manufacturer to carry out only one function. It refers to a number of intelligent devices that have some microprocessor to automate them. For example, electronic fuel pump, ATM machine, electronic washing machine, digital television, etc. General purpose computers on the other are computers that can be modified to perform any functions by loading the necessary software. Business application computers are general purpose and therefore can be programmed with variety of user applications.

**4.2. History of computers**
The history of computers can be traced back to almost 2000 years ago, with the advent of *abacus*, a wooden rack holding two horizontal wires with beads strung on them. Numbers are represented using the position of beads on the rack. Fast and simple calculations can be carried out by appropriately placing the beads.
In 1620, an English mathematician by the name William Oughtred invented the slide rule – a calculating device based on the principle of logarithms. It consisted of two graduated scales devised in such a manner that suitable alignment of one scale against the other, made it possible to perform additions, compute products etc. just by inspection.

Blaise Pascal, a French mathematician, is usually credited for building the first digital computer in 1642. He invented the mechanical calculating machine. Numbers were entered in this machine by dialing a series of numbered wheels. Another series of toothed wheels transferred the movements to a dial, which showed the results.

In 1671, Gottfried von Leibnitz, a German mathematician, invented a calculating machine which was able to add and perform multiplications. He invented a special stepped gear mechanism for introducing the addend digits, which is still being used.

The prototypes made by Pascal and Leibnitz were not used in many places. It was only about a century later that Thomas of Colmar created the first successful mechanical calculator which could add, subtract, multiply, and divide. A lot of improved desktop calculators by various inventors followed, such that by 1890 a range of improvements like accumulation of partial results, storage of past results, and printing of results were not uncommon.

5. 1.3.1 The First Computer

Charles Babbage, a professor of mathematics at Cambridge University, England, realized that many long calculations usually consisted of a series of actions that were constantly repeated and hence could possibly be automated. By 1822, he designed an automatic calculating machine that he called the ‘Difference Engine’. It was intended to be steam powered and fully automatic (including printing of result tables), commanded by a fixed instruction program. In short, he developed a prototype of a computer which was 100 years ahead of time and is, therefore, considered as the father of modern day computers.

A step towards automated computing was the development of punched cards which were first successfully used by Herman Hollerith, who worked in the US Census Bureau in 1890. He along with James Powers developed devices that could read information that had been punched into cards, without any human help. This resulted in reduced reading errors, increased workflow and availability of unlimited memory (punched cards could be used as easily accessible memory of unlimited size).

These advantages were seen by various commercial companies and soon led to the development of improved punch-card using computers by companies like International Business Machines (IBM) and Remington.

6. 1.3.2 Some Well Known Early Computers

Mark I

After World War II there was a need felt for advanced calculations. By that time, many reliable mechanical desk calculators had been developed. Howard A. Aiken of Harvard University, while working on his doctorate in physics, in the year 1937, designed a machine that could automatically perform a sequence of arithmetic operations. He completed this in 1944 and named it Mark I. This machine performed a multiplication and division at an average of about four and eleven seconds respectively. The results were printed at a rate of one result per five seconds.

ENIAC

The World War II also produced a large need for computer capacity especially for the
military. New weapons were made for which trajectory tables and other essential data were needed. In 1942, Professors John P. Eckert and John W. Mauchly at the Moore School of Engineering of the University of Pennsylvania, USA, decoded to build a high speed computer to do the job. This was called the Electronic Numeric Integrator and Calculator (ENIAC).

It used 18,000 vacuum tubes, about 1,800 square feet of floor space, and consumed about 180,000 watts of electrical power. It had punched cards I/O and its programs were wired on boards.

ENIAC is accepted as the first successful high-speed electronic digital computer and was used from 1946 to 1955.

**EDVAC**

Fascinated by the success of ENIAC, John Von Neumann, a mathematician, undertook an abstract study of computation in 1945. In this he aimed to show that a computer should be able to execute any kind of computation by means of a proper programmed control. His ideas, referred to as ‘stored program technique’, became essential for future generations of high-speed digital computers and were universally accepted. The basic idea behind the stored program concept was that data as well as instructions can be stored in the computer’s memory to enable automatic flow of operations.

Between 1947 and 1950, the Moore School personnel and the Ballistics Research Laboratory of the US army built a computer named Electronic Discrete Variable Automatic Computer (EDVAC), which was based on Von Neumann’s concept of stored program.

**UNIVAC**

The Universal Automatic Computer (UNIVAC), developed in 1951, was the first digital computer to be produced and was installed in the Census Bureau.

The first-generation stored-program computers needed a lot of maintenance, reached 70% to 80% reliability of operations and were used for almost 10 years. EDVAC and UNIVAC fell into this group of computers and were the first commercially available computers.

7. **1.3.3 Computer Generations**

‘Generation’ in computer terminology is a ‘step’ ahead in technology. As you go through the history of evolution of computers, you will find that the earliest computers were big in size, consumed a lot of power and heated up quickly, due to which it had to be shut down, frequently to be cooled. They were very expensive in terms of development and maintenance.

As technology improved, computers became compact, faster and more powerful. From a user’s perspective, they become user friendly and more affordable. This has largely contributed towards the popularity that computers have gained these days.

The term ‘generation’ was earlier used only to distinguish between varying hardware technologies but was later extended to include both hardware and software. A comparison of generations is made below.

**First Generation Computers (1940 to 1956)**

The first generation of computers was characterized by vacuum tubes in the circuitry and magnetic drums for memory.

These computers were enormous in size, used great deal of electricity and were expensive to operate. They also had limited storage capacity.
First generation computers relied on machine language (binary-coded program) to perform operations and could solve only one problem at a time. Punched cards and paper tapes were used to input data and instructions, and output was displayed on printouts. Early computers like ENIAC, EDVAC and UNIVAC can all be classified as first generation computers.

**Second Generation Computers (1956 to 1963)**
In the early 1950s, the discoveries of Transistor and Magnetic core memory changed the image of computers – from unreliable to highly reliable machines with increased capability, and higher storage capacity.

The transistor was far superior to the vacuum tube, allowing computers to become smaller in size, cheaper, reliable and more energy efficient. Though transistor still generated a great deal of heat, it was a substantial improvement over the vacuum tube.

Second generation of computers was also characterized by allowing programmers to specify instructions in symbolic (or assembly) language rather than cryptic binary machine language. High level programming languages like COmmon Business Oriented Language (COBOL) and FORmula TRANslaton (FORTRAN) were also being developed at this time.

Due to the increase in the cost of expanding programming, these machines were expensive to purchase and operate. Such computers were, therefore, mostly found in large computer centres or government/private laboratories with many programmers and support professionals.

**Third Generation Computers (1964 to 1971)**
The development of Integrated Circuit by Jack Kilby, an engineer with Texas Instruments, in 1958, was the hallmark of the third generation of computers. Punched cards and printouts gave way to devices like keyboards and monitors making it easier for the user to interact with the computer. Computer manufacturers could provide a range of accessories like the cathode ray tube display devices, page printers, consoles etc.

Existence of an operating system allowed the device to run various applications at one time with the central program monitoring the memory.

For the first time, computers were being widely used in business for areas like:
- Accounting
- Payroll
- Billing
- Tracking Inventory, etc.

Third generation computers were substantially smaller and cheaper than their predecessors.

**Fourth Generation Computers (1971 to present)**
The trend in 1970s was to move from single-purpose but powerful computers towards cheaper computer systems that could support a large range of applications.
A new revolution in computer hardware came about which could shrink the computer logic circuitry and its components using the Large Scale Integration (LSI) technology. Hundreds of components could now fit onto a single chip!

In the 1980s, Very Large Scale Integration (VLSI) squeezed hundreds of thousands of components onto a single chip. This shrinking trend continued and led to the introduction of personal computers (PCs) – programmable machines that are small enough and inexpensive so that these can be purchased and used by individuals. Companies like Apple Computers and IBM introduced very successful PCs.

The IC technology was not only used to construct the processor, but also for the construction of memory. The first memory chip was constructed in 1970 and could hold 256 bits.

Fifth Generation Computers (the Road Ahead)

The fifth generation of computers characterized by artificial intelligence is in the process of development. The goal here is to develop devices that are capable of learning and responding to natural language input. This generation of computers is using new technologies in very large scale integration, along with new programming languages and will be capable of amazing feats, in the area of artificial intelligence, such as voice recognition.

8. CHAPTER 2: Computer Arithmetic

8.1. Number systems

Data Representation inside a computer

All data stored in a computer is coded into binary digits. However, computer data coding can also use a number of other data coding systems including octal and hexadecimal. Below is some examples to illustrate the arithmetic conversions and operations of these number systems including decimal systems.

**Binary**

Base or radix 2 number system

Binary digit is called a bit.

Numbers are 0 and 1 only.

Numbers are expressed as powers of 2.

\[
2^0 = 1, \quad 2^1 = 2, \quad 2^2 = 4, \quad 2^3 = 8, \quad 2^4 = 16, \quad 2^5 = 32, \quad 2^6 = 64, \quad 2^7 = 128, \quad 2^8 = 256, \quad 2^9 = 512, \\
2^{10} = 1024, \quad 2^{11} = 2048, \quad 2^{12} = 4096, \quad 2^{13} = 8192, \ldots
\]
Conversion of binary to decimal (base 2 to base 10)

Example: convert \((110011)_2\) to decimal

\[
= (1 \times 2^5) + (1 \times 2^4) + (0 \times 2^3) + (0 \times 2^2) + (1 \times 2^1) + (1 \times 2^0) \\
= 32 + 16 + 0 + 0 + 2 + 1 \\
= (51)_{10}
\]

Conversion of decimal to binary (base 10 to base 2)

Example: convert \((51)_{10}\) to binary

\[
51 \div 2 = 25 \text{ remainder is 1} \\
25 \div 2 = 12 \text{ remainder is 1} \\
12 \div 2 = 6 \text{ remainder is 0} \\
6 \div 2 = 3 \text{ remainder is 0}
\]
3 \div 2 = 1 \text{ remainder is 1}

1 \div 2 = 0 \text{ remainder is 1}

Answer = 1 1 0 0 1 1

Note: the answer is read from bottom (MSB) to top (LSB) as $110011_2$

**Octal**

Base or radix 8 number system

1 octal digit is equivalent to 3 bits.

Numbers are 0-7.

Numbers are expressed as powers of 8. $8^0 = 1$, $8^1 = 8$, $8^2 = 64$, $8^3 = 512$, $8^4 = 4096$.

**Conversion of octal to decimal (base 8 to base 10)**

*Example:* convert $(632)_8$ to decimal

\[
= (6 \times 8^2) + (3 \times 8^1) + (2 \times 8^0) \\
= (6 \times 64) + (3 \times 8) + (2 \times 1) \\
= 384 + 24 + 2 \\
= (410)_{10}
\]
Conversion of decimal to octal (base 10 to base 8)

Example: convert \((177)_{10}\) to octal

\[
177 \div 8 = 22 \text{ remainder is 1}
\]
\[
22 \div 8 = 2 \text{ remainder is 6}
\]
\[
2 \div 8 = 0 \text{ remainder is 2}
\]

Note: the answer is read from bottom to top as \((261)_8\), the same as with the binary case.

Hexadecimal

Base or radix 16 number system

1 hex digit is equivalent to 4 bits.

Numbers are 0-9, A, B, C, D, E, and F.

\[
(A)_{16} = (10)_{10}, \ (B)_{16} = (11)_{10}, \ (C)_{16} = (12)_{10}, \ (D)_{16} = (13)_{10}, \ (E)_{16} = (14)_{10}, \ (F)_{16} = (15)_{10}
\]

Numbers are expressed as powers of 16.

\[16^0 = 1, \ 16^1 = 16, \ 16^2 = 256, \ 16^3 = 4096, \ 16^4 = 65536, \ldots\]

Conversion of hexadecimal to decimal (base 16 to base 10)

Example: convert \((F4C)_{16}\) to decimal

\[
(\begin{align*}
(F \times 16^2) + (4 \times 16^1) + (C \times 16^0) \\
(15 \times 256) + (4 \times 16) + (12 \times 1) \\
3840 + 64 + 12 \\
(3916)_{10}
\end{align*})
\]
Conversion of decimal to hex (base 10 to base 16)

*Example:* convert \((77)_{10}\) to hex

\[
77 \div 16 = 4 \text{ remainder is D} \\
4 \div 16 = 0 \text{ remainder is 4}
\]

Note: the answer is read from bottom to top as \((4D)_{16}\), the same as with the binary case.

<table>
<thead>
<tr>
<th>Decimal</th>
<th>Binary</th>
<th>Octal</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0000</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0001</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>0010</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>0011</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>0100</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>0101</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>0110</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>0111</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>1000</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>1001</td>
<td>11</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>1010</td>
<td>12</td>
<td>A</td>
</tr>
</tbody>
</table>
Conversion of Octal and Hex to Binary

Conversion of octal and hex numbers to binary is based upon the the bit patterns shown in the table above and is straight forward. For octal numbers, only three bits are required. Thus $6_8 = 110_2$, and $345_8 = 11100101_2$. For hex numbers, four bits are required. Thus $E_{16} = 1110_2$, and $47D_{16} = 10001111101_2$.

Conversion of Binary to Octal and Hex

Conversion of binary numbers to octal and hex simply requires grouping bits in the binary numbers into groups of three bits for conversion to octal and into groups of four bits for conversion to hex. Groups are formed beginning with the LSB and progressing to the MSB. Thus, $11100111_2 = 347_8$ and $111000101010100100011_2 = 7025221_8$. Similarly, $11100111_2 = E7_{16}$ and $11000101010000111_2 = 18A87_{16}$.
Binary Arithmetic

Binary Addition

<table>
<thead>
<tr>
<th>+</th>
<th>0</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>10</td>
</tr>
</tbody>
</table>

Binary Addition Table

The entry for 1+1 is 10 which indicates a carry of 1

Examples

<table>
<thead>
<tr>
<th>Addend</th>
<th>1011</th>
<th>1011</th>
<th>1011</th>
<th>1011</th>
<th>1011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Augend</td>
<td>+ 100</td>
<td>+ 100</td>
<td>+ 100</td>
<td>+ 100</td>
<td>+ 100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sum</th>
<th>1</th>
<th>11</th>
<th>111</th>
<th>1111</th>
</tr>
</thead>
<tbody>
<tr>
<td>carry</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Addend</th>
<th>1101</th>
<th>1101</th>
<th>1101</th>
<th>1101</th>
<th>1101</th>
<th>1101</th>
</tr>
</thead>
<tbody>
<tr>
<td>Augend</td>
<td>+ 1001</td>
<td>+ 1001</td>
<td>+ 1001</td>
<td>+ 1001</td>
<td>+ 1001</td>
<td>+ 1001</td>
</tr>
</tbody>
</table>
Binary Subtraction

Uses the same principle of "borrowing" that decimal subtraction uses.

\[
\begin{array}{c|c|c}
   & 0 & 1 \\
\hline
0 & 0 & 1 \text{ (with a borrow from the next column)} \\
1 & 1 & 0 \\
\end{array}
\]

Binary Subtraction Table

Example

<table>
<thead>
<tr>
<th>borrow</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
</tr>
<tr>
<td>01</td>
</tr>
<tr>
<td>01</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Minuend</th>
<th>10100</th>
<th>10100</th>
<th>10100</th>
<th>10100</th>
<th>10100</th>
<th>10100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subtrahend</td>
<td>- 1001</td>
<td>- 1001</td>
<td>- 1001</td>
<td>- 1001</td>
<td>- 1001</td>
<td>- 1001</td>
</tr>
</tbody>
</table>
Difference

01011

1 11 011 1011

Note: This problem in decimal is 20 – 9 = 11 which is the answer we get in binary.

8.2. Working with signed numbers

Representation of negative numbers (2’s complement)

The 2’s complement of a binary number is defined as the value obtained by subtracting the number from a large power of two (specifically, from $2^N$ for an $N$-bit 2’s complement). The 2’s complement of the number then behaves like the negative of the original number in most arithmetic, and it can coexist with positive number in a natural way. A 2’s complement negative number binary representation can be found for an $n$-bit number by applying the following simple equation:

$$N^* = 2^n - N$$

For example, to represent $-3$ as a 4-bit 2’s complement number, one can apply the above equation or simply take the positive binary representation, complement the bits, and add 1.

$$-3 = 2^4 - 1 = 16 - 3 = 13 = 1101_2$$

$$3 = 0011_2 - 3 = 1100_2 + 1 = 1101_2$$

Arithmetic overflow

Since $n$-bit binary numbers are of fixed length, there are only a fixed set of numbers that can be represented; therefore, it is possible to perform arithmetic on two $n$-bit binary numbers and get a condition known as overflow. An overflow occurs when an arithmetic operation of two words of
length n-bits sum to a result that requires more than n-bits to correctly represent. This is true for both unsigned and signed binary numbers.

For example, adding the following two 4-bit unsigned numbers will result in an overflow:

\[ 8 + 8 = 16 \rightarrow 1000_2 + 1000_2 = 1 0000_2 = 0 \neq 16 \]

For example, adding the following two 4-bit signed numbers will result in an overflow:

\[-8 + -8 = -16 \rightarrow 1000_2 + 1000_2 = 1 0000_2 = 0 \neq -16 \]

There are few simple statements to remember for 2’s complement numbers in order to know if an overflow has occurred for a signed number:

1) If adding two negative signed numbers results in a positive number, an overflow has occurred.
2) If adding two positive signed numbers results in a negative number, an overflow has occurred.
3) For two n-bit signed numbers, it is impossible to get an overflow when adding a positive number and a negative number, or subtracting a positive number from another positive number.
4) If subtracting two numbers, take 2’s complement of the subtrahend (number being subtracted) and perform addition using rules 1) – 3) above.

**8.3. Character set encoding ASCII and EBCDIC**

Character set encoding systems

A character is a digit, an alphabet or a symbol that can be stored and manipulated by a computer. They 0,1,2...9, A,B,C,...Z, a,b,c,..., Z, ,.:;'"[]{}|, etc. The American Standard Code for Information Interchange and the Extended Binary Coded Decimal Interchange Code are two character encoding schemes; which are more commonly known by their respective acronyms, ASCII and EBCDIC. The main difference between the two is the number of bits that they use to represent each character. EBCDIC uses 8 bits per character while the original ASCII standard only used 7, due to concerns that using 8 bits for characters that can be represented with 7 is much less efficient.

The main consequence of that difference is the number of characters that can be accommodated with each one. EBCDIC can accommodate up to 28 characters for a total of 256 while the 27 of ASCII has a maximum of 128 characters.

Although EBCDIC was very popular, due largely to the popularity of IBM machines at the time, it had several problems that irritated programmers. The first one is how it arranges the letters of the alphabet. In ASCII, all the letters are in consecutive order. Capital letters are grouped together
while small letters also have their own group. In EBCDIC, the letters are grouped 9 at a time. This non-intuitive layout comes from the EBCDIC’s punch card origins and is quite difficult for programmers to deal with.

IBM’s hold of the EBCDIC coding has led to many problems when it comes to updates. ASCII and EBCDIC later had updates to increase the number of characters that they can accommodate. ASCII pages had some code points replaced while maintaining most of the other code points. With EBCDIC, the different versions are highly incompatible with each other.

As the encoding needs of computer outgrew both ASCII and EBCDIC, other standard emerged. The most recent is Unicode, which incorporated ASCII. The first 128 characters of Unicode are from ASCII. This lets Unicode open ASCII files without any problems. On the other hand, the EBCDIC encoding is not compatible with Unicode and EBCDIC encoded files would only appear as gibberish.

Summary:

Therefore, EBCDIC uses 8 bits while ASCII uses 7 bits.

9. CHAPTER 3: Computer Hardware

9.1. Basic Computer Elements - Hardware & Software

9.2. Hardware Components

Modern computers are electronic and digital in contrast to analog computers which would be electromechanical measuring devices. The actual physical components -- wires, transistors, and circuits -- is called hardware; the instructions and data are called software.

The electrical, electronic, mechanical and magnetic components that make up the computer system are together termed as ‘hardware’. These include components that are responsible for user input, display and mathematical processing. The CPU, disk drives, internal chips and wiring, modem, peripheral devices like the monitor, keyboard, mouse, printer, speakers etc. are together termed as computer hardware. Computer hardware cannot perform any manipulation or calculation without being instructed as to what to do and how to do it. Programs (or instructions) are required to tell the computer.
what to do. The generic term for computer programs is ‘software’. Software comes in two main types – system software and application programs.

9.2.1. Input

Input Unit

Data and instructions must be entered into the computer system for processing, and results obtained from computations must be displayed or recorded for the user. The input device serves the purpose of receiving data and instructions in a form that can be understood by the computer.

10.

1. **Manual Input Devices for Human Input** are the most common devices.
   a. **Keyboard** – most common input device, like a typewriter with additional function keys and cursor movement keys; ergonomic keyboards are now available; users should be very careful to use proper hand and wrist movements to avoid carpal tunnel syndrome.
   b. **Mouse** – point-and-click device that lets the user move the device to move the cursor on the screen, point and click to make a choice, and point and drag objects in a graphical user interface environment (GUI).
   c. **Trackball** – similar to a mouse, but the device doesn’t move, a round ball rotates to move the cursor; found on notebook/laptop computers (in addition to touchpads where a finger is moved on a pad to move the cursor).
   d. **Stylus** – a rubberized pen device on PDAs to allow the user to touch options or write on a sensitive screen.
   e. **Microphone** – used for voice recognition input; important to have a strong and clear signal.

2. **Input Devices for Source Data Automation (direct data entry- DDE)** improve the speed and accuracy of data input by capturing the data at the time of the transaction.
   a. **Magnetic recognition** – includes magnetic ink character recognition (MICR), magnetic cards, and smart cards; used in the banking industry since the 1950s; used today on cards similar to credit cards, smart cards are enhanced with a microprocessor on the card to allow data to be stored.
   b. **Touch-sensitive screens** – allow a person to point with finger and touch certain parts of the screen; sensors make it an interactive device.
   c. **Optical recognition** -scans the data for input; includes optical mark recognition (OMR), which is the simplest scanning technology, when a pencil mark is made in a predetermined grid; bar code, which is what the UPC code is on products; and optical character recognition (OCR) to recognized letters, numbers, or special characters.
   d. **Voice input**-converts the human voice to digital impulses so the computer can process the data; takes a lot of practice for the computer to understand your voice accurately.
   e. **Visual input**-pattern recognition systems that require a camera to be a computer’s eye.
10.1.1. Output

Output Unit

The processed data, stored in the memory of the computer is sent to the output unit, which then converts it into a form that can be understood by the user. The output is usually produced in one of the two ways – on the display device, or on paper (hard copy).

1. **Output Media** include paper, display, and voice.
   a. **Paper output** – used often so people can readily use the information; referred to as a hard copy.
   b. **Display output** – on a screen; must be saved on a secondary storage device to be permanent; includes microfilm and microfiche; often referred to as a soft copy.
   c. **Voice response system** – sound chips embedded in the hardware; includes beeps and verbal responses to the user; prevalent in computer business applications; more advanced systems use speech synthesizers to convert data into speech.

11. 2. **Output Devices**

a. **Monitors** – vary in their quality; flat-panel monitors utilize newer technology.
   - Evaluate the viewable size of a monitor relative to the actual size.
   - The resolution includes pixels (short for picture element) and dot pitch (distance between centers of adjacent pixels); the lower the dot pitch, the greater number of pixels in the display and the higher the resolution.
   - Flat-panel monitors use LCD (tiny transistors to reflect light through the liquid crystal to produce high resolution output) and plasma technology (tiny light bulbs to ignite the phosphor to produce high-resolution output with little trailing edge blur).

b. **Printers** – chosen based on print quality, speed, and cost.
   - Impact printers are noisy, slow, and low-quality for graphics. When used for multi-part forms, dot matrix is most common; inexpensive.
   - Non-impact printers include ink jet types that use fast-drying ink sprayed in droplets to form the characters; relatively low cost and offer many features to make them popular in office environments.
   - Non-impact printers also include laser printers, which use intense low-power light beam capable of carrying millions of characters; very high-resolution for text and graphics, very fast; capable of duplexing and using different paper sizes; costs coming down, making them more attractive in the office.

c. **Plotters** – used for large drawings; drum and table plotters move the paper past a stylus bi-directionally; use roll-feed paper up to 4 feet wide and 50 feet long; popular in engineering, drafting and graphic arts.

d. **Speakers** – used with a voice-response system; can be an additional peripheral or built-in.

11.1.1. Storage

*Main Memory*
The main memory holds data and instructions after input, till they are needed. It also holds the processed results that are awaiting output.

**Secondary Storage**

Also termed as ‘auxiliary’ or ‘backup’ storage, it is typically used as a supplement to main storage. It is much cheaper than the main storage and stores large amount of data and instructions permanently. Hardware devices like magnetic tapes and disks fall under this category.

1. **Secondary Storage** – nonvolatile, long-term; data is not lost when the power is turned off; auxiliary to primary storage and is outside the processor unit; most common types:
   a. **Hard disk** – fixed disk (non-removable) and external (removable) hard disks; today range in size from 20 GB to 1000 GB.
   b. **Magnetic disk** – common for microcomputers; removable from disk drive, data transported from place to place; size varies with disk density and quality; protect disk to keep data safe, a disk with a bad sector cannot be used any longer. USB flash drive is an external, portable storage drive that can be carried in your pocket; can hold 250 MB of data.
   c. **Optical disc** – uses laser beam of light to store and read data instead of magnetic processes; burns microscopic pits onto the disk tracks as data are stored; shelf life of 30 years. Includes CD-ROM (read-only, holds approximately 650 MB of data), CD-R (recordable CD, can write to one time and then read only), CD-RW (rewritable CD, can store, access, and reuse discs the same as a magnetic disk; rewritable nearly a million times without a decline in accuracy), DVD (digital video disk provides high resolution, true color, and no flicker output; can be read only, recordable, or rewritable like CDs).
   d. **RAID** – redundant arrays of independent disks; combine 10-100 small hard disks drives into a single unit, specialized microcontroller coordinates the hard drives’ microprocessors so it appears as a single drive.
   e. **Magnetic tapes** – first form of secondary storage to be widely used; sequential access only, storage capacity greater than 200 MB, transfer rate of 50,000-400,000 bps; popular backup medium.
   f. **Storage area network** – a high-speed fiber channel local area network dedicated to storage that interconnects different storage devices; expensive and difficult to manage; enterprise-wide infrastructure provides rapid sharing and access to the organization’s stored data.

11.1.2. **Central Processing Unit**

**Central Processing Unit**

The CPU is also responsible for controlling the operations of various units of the computer system.

*Arithmetic Logic Unit (ALU)*

All calculations and comparisons, based on the instructions provided, are carried out within the ALU. It performs arithmetic functions like addition, subtraction, multiplication, division and also logical operations like greater than, less than and equal to.

*Control*
The function of the control unit is to execute the instructions of a program, one by one, in the desired sequence. It interprets each instruction and then prompts its execution by one of the units like input, output, ALU, storage. For example, a comparison of two numbers (a logical operation) to be performed by the ALU may require loading the two numbers into the main memory which is a function performed by the control unit. It will then pass on the execution of the ‘compare’ function to the ALU.

12. CHAPTER 4: Computer Software

Computer software, or just software, is any set of machine-readable instructions (most often in the form of a computer program) that directs a computer's processor to perform specific operations.

Software is divided into two basic categories;
- System Software, and
- Applications software

12.1. System Software
System software consists of the programs that control the operations of a computer and its devices. The two types of system software are operating systems and utility programs. An operating system (OS) is a set of programs containing instructions that coordinate all the activities among computer hardware devices. A utility program performs a specific task, usually related to managing a computer, its devices, or its programs. They include; Desktop enhancers – Change the desktop look and organization, allowing users to create and switch between multiple desktops. File conversion – Converts from one file format to another so that a file can be used by another application. Internet organizers – Helps in the management and use of favorite Web sites, searching the Web and reporting on site changes. Antivirus programs – Prevent, detect, and remove computer viruses.

12.1.1. Operating Systems
Most operating systems perform similar functions that include managing programs, managing memory, scheduling jobs, configuring devices, accessing the Web, monitoring performance, providing housekeeping services, and administering security. Managing programs directly affects your productivity. A single user/single tasking operating system allows only one user to run one program at a time. A multitasking operating system allows a single user to work on two or more applications that reside in memory at the same time. A multi-user operating system enables two or more users to run a program simultaneously.

A multiprocessing operating system can support two or more CPUs running programs at the same time. Managing memory involves assigning items to an area of memory while they are being processed. The purpose of memory management is to optimize use of random access memory (RAM). With virtual memory (VM), the operating system optimizes memory by allocating a portion of a storage medium, usually the hard disk, to function as additional RAM. Scheduling jobs (operations the processor manages) involves determining the order in which jobs are processed.
Spooling increases efficiency by placing print jobs in a buffer (an area of memory or storage where data resides while waiting to be transferred) until the printer is ready, freeing the processor for other tasks. Configuring devices establishes communication with each device in the computer. A device driver is a small program that tells the operating system how to communicate with a device. Accessing the Web may entail including a Web browser and e-mail program in the operating system. Monitoring performance helps to identify and solve system problems.

A performance monitor is a program that assesses and reports information about various system resources and devices. Providing housekeeping services entails performing storage and file management functions. A file manager performs such functions as formatting and copying disks; listing the files on a storage medium; checking the amount of used and unused space on a storage medium; organizing, copying, deleting, moving, and sorting files; and creating shortcuts (icons on the desktop that run a program when clicked).

Administering security involves establishing user accounts on a network. Each account typically requires a user name and a password to log on, or access, the network.

Q: Discuss the functions of an operating system

Know the difference between stand-alone operating systems and network operating systems

A stand-alone operating system is a complete operating system that works on a desktop or notebook computer. A network operating system (also called network OS or NOS) is an operating system that supports a network. A network is a collection of computers and devices connected together via communications media and devices such as cables, telephone lines, and modems. In some networks, the server is the computer that controls access to the hardware and software on a network and provides a centralized storage area. The other computers on the network, called clients, rely on the server(s) for resources.

Identify various stand-alone operating systems


DOS (Disk Operating System) refers to several single user, command-line and menu-driven operating systems developed in the early 1980s for personal computers. Windows 3.x refers to early operating environments that, although not operating systems, provided a graphical user interface to work in combination with DOS and simplify its use. Windows 95 is a true multitasking operating system – not an operating environment – with an improved graphical interface. Windows NT Workstation is a client operating system that can connect to a Windows NT Server. Developed as an upgrade to Windows 95, the Windows 98 operating system is easier to use and more integrated with the Internet. Windows 98 includes Microsoft Internet Explorer, a popular Web browser, Windows Explorer, a file
manager, and an Active Desktop™ that works similarly to Web links. Windows 2000 Professional is a complete, reliable multitasking client operating system for business desktop and business notebook computers. Windows Millennium Edition is an operating system that has features specifically for the home user. Windows XP is Microsoft’s fastest, most reliable Windows operating system, providing quicker startup, better performance, and a new, simplified visual look. Windows XP Home Edition is an upgrade to Windows Millennium Edition, while Windows XP Professional Edition is an upgrade to Windows 2000 Professional.

The Mac OS, the latest version of the Macintosh operating system (the first commercially successful graphical user interface), is a multitasking operating system available only on Apple computers. OS/2 Warp Client is IBM’s GUI multitasking client operating system that supports networking, Java, the Internet, and speech recognition.

Identify various network operating systems


OS/2 Warp Server for E-business is IBM’s network operating system designed for all sizes of business.

UNIX is a multitasking, command-line operating system implemented on many different types of computers. Because it is both a stand-alone operating system and a network operating system, some call UNIX a multipurpose operating system. Linux is a popular, free, multitasking UNIX-type operating system. Solaris™, a version of UNIX developed by Sun Microsystems, is a network operating system designed for e-commerce applications.

12.1.2. Utilities

Define the Term Utility Software and discuss the purpose of the following utilities: file viewer, file compression, diagnostic, uninstaller, disk scanner, disk defragmenter, backup, and screen saver, anti-virus, CD writing software, games, movie player, etc.

Most operating systems include several utility programs that perform specific tasks related to managing a computer, its devices, or its programs. A file viewer is a utility that allows you to display and copy the contents of a file. A file compression utility shrinks the size of a file. A diagnostic utility compiles technical information about a computer’s hardware and certain system software programs and then prepares a report outlining any identified problems. An uninstaller is a utility that removes an application, as well as any associated
entries in the system files. A disk scanner is a utility that (1) detects and corrects both physical and logical problems on a hard disk, and (2) searches for and removes unnecessary files.

A disk defragmenter is a utility that reorganizes files and unused space on a computer’s hard disk so data can be accessed more quickly and programs can run faster. A backup utility copies, or backs up, selected files or an entire hard drive onto another disk or tape. A screen saver is a utility that causes the monitor’s screen to display a moving image on a blank screen if no keyboard activity occurs for a specified period.

12.2. Application Programs
Application software consists of programs designed to perform specific tasks for users. Application software can be used as a productivity/business tool; to assist with graphics and multimedia projects; to support home, personal, and educational activities; and to facilitate communications. Specific application software products, called software packages, are available from software vendors. Although application software also is available as shareware, freeware, and public-domain software, these usually have fewer capabilities than retail software packages.

People use productivity software to become more effective and efficient while performing daily activities. Word processing software allows users to create and manipulate documents that contain text and graphics. With word processing software, you can insert clip art into a document; change margins; find and replace text; use a spelling checker to check spelling; place a header and footer at the top and the bottom of a page; and vary font (character design), font size (character scale), and font style (character appearance).

With spreadsheet software, data is organized in rows and columns, which collectively are called a worksheet. The intersection of a row and column, called a cell, can contain a label (text), a value (number), or a formula or function that performs calculations on the data and displays the result.

Database software allows you to create and manage a database. A database is a collection of data organized to allow access, retrieval, and use of that data. A query is used to retrieve data according to specified criteria, which are restrictions the data must meet.

Presentation graphics software is used to create presentations that communicate ideas, messages, and other information to a group through a slide show. You can use a clip gallery to enhance your presentation with clip art images, pictures, video clips, and audio clips.

A personal information manager (PIM) is software that includes an appointment calendar to schedule activities, an address book to maintain names and addresses, and a notepad to record ideas, reminders, and important information. A software suite is a collection of individual applications sold as a single package.

Project management software allows you to plan, schedule, track, and analyze the progress of a project. Accounting software helps companies record and report their financial transactions.
Power users often use software that allows them to work with graphics and multimedia. Computer-aided design (CAD) software assists in creating engineering, architectural, and scientific designs. Desktop publishing (DTP) software is used to design and produce sophisticated documents. DTP is developed specifically to support page layout, which is the process of arranging text and graphics in a document. Paint software is used to draw graphical images with various on-screen tools. Image editing software provides the capability to modify existing images. Video editing software and audio editing software can be used to modify video and audio segments.

Multimedia authoring software is used to create electronic interactive presentations that can include text, images, video, audio, and animation. Web page authoring software is designed to create Web pages and to organize, manage, and maintain Web sites.

Many software applications are designed specifically for use at home or for personal or educational use. Integrated software combines several productivity software applications that share a similar interface and common features into a single package. Personal finance software is an accounting program that helps pay bills, balance a checkbook, track income and expenses, follow investments, and evaluate financial plans. Legal software assists in the creation of legal documents and provides legal advice. Tax preparation software guides users through the process of filing federal taxes. Personal DTP software helps develop conventional documents by asking questions, presenting predefined layouts, and supplying standard text.

Photo-editing software is used to edit digital photographs. A clip art/image gallery is a collection of clip art and photographs that can be used in all types of documents. Home design/landscaping software assists with planning or remodeling. Educational software teaches a particular skill and exists for about any subject. Reference software provides valuable and thorough information for all individuals. Entertainment software includes interactive games, videos, and other programs designed to support a hobby or provide amusement.

13. CHAPTER 5: Types of Computer Instruction Set Architecture

An instruction set, or instruction set architecture (ISA), is the part of the computer architecture related to programming, including the native data types, instructions, registers, addressing modes, memory architecture, interrupt and exception handling, and external I/O. An ISA includes a specification of the set of opcodes (machine language), and the native commands implemented by a particular processor.

13.1. RISC versus CISC processors

Classification of instruction sets

There are two basic types of instruction sets architectures of processors; complex instruction set computer (CISC) and reduced instruction set computer (RISC).

CISC

CISC is an instruction set design where each instruction in a CISC instruction set is meant to perform a series of operations inside the processor. This reduces the number of instructions required to
implement a given program, and allows the programmer to learn a small but flexible set of instructions. The philosophy behind it is that hardware is always faster than software, therefore one should make a powerful instruction set, which provides programmers with assembly instructions to do a lot with short programs. Intel and AMD processors normally use CISC instruction set design.

RISC

RISC chips evolved around the mid-1980 as a reaction at CISC chips. The philosophy behind it is that fewer, simpler and faster instructions would be better, than the large, complex and slower CISC instructions. However, more instructions are needed to accomplish a task.

An other advantage of RISC is that - in theory - because of the more simple instructions, RISC chips require fewer transistors, which makes them easier to design and cheaper to produce. Finally, it's easier to write powerful optimised compilers, since fewer instructions exist.

RISC vs CISC

There is still considerable controversy among experts about which architecture is better. Some say that RISC is cheaper and faster and therefore the architecture of the future.

Others note that by making the hardware simpler, RISC puts a greater burden on the software. Software needs to become more complex. Software developers need to write more lines for the same tasks.

Therefore they argue that RISC is not the architecture of the future, since conventional CISC chips are becoming faster and cheaper anyway.

RISC has now existed more than 10 years and hasn't been able to kick CISC out of the market and at least 75% today's PCs, workstations and servers processors are based on the CISC architecture. Most of them the x86 standard (Intel, AMD, etc.), but even in the mainframe territory CISC is dominant via the IBM/390 chip. Looks like CISC is here to stay ...

Is RISC than really not better? The answer isn't quite that simple. RISC and CISC architectures are becoming more and more alike. Many of today's RISC chips support just as many instructions as yesterday's CISC chips. The PowerPC 601, for example, supports more instructions than the Pentium. Yet the 601 is considered a RISC chip, while the Pentium is definitely CISC. Further more today's CISC chips use many techniques formerly associated with RISC chips.

So simply said: RISC and CISC are growing to each other.

14. CHAPTER 6: Ms Word

14.1. Introduction to Ms Word


16. Microsoft Word Training

This Microsoft Word training is free and online. After completing this training you will be proficient in Microsoft Word.

Lesson 1: Getting Familiar with Microsoft Word 2007 for Windows
Microsoft Word is a word processing software package. You can use it to type letters, reports, and other documents. This tutorial teaches Microsoft Word 2007 basics. Although this tutorial was created for the computer novice, because Microsoft Word 2007 is so different from previous versions of Microsoft Word, even experienced users may find it useful.

This lesson will introduce you to the Word window. You use this window to interact with Word. To begin this lesson, open Microsoft Word 2007. The Microsoft Word window appears and your screen looks similar to the one shown here.

Note: Your screen will probably not look exactly like the screen shown. In Word 2007, how a window displays depends on the size of your window, the size of your monitor, and the resolution to which your monitor is set. Resolution determines how much information your computer monitor can display. If you use a low resolution, less information fits on your screen, but the size of your text and images are larger. If you use a high resolution, more information fits on your screen, but the size of the text and images are smaller. Also, Word 2007, Windows Vista, and Windows XP have settings that allow you to change the color and style of your windows.

17. The Microsoft Office Button
In the upper-left corner of the Word 2007 window is the Microsoft Office button. When you click the button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and perform many other tasks.

18. The Quick Access Toolbar
Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar provides you with access to commands you frequently use. By default Save, Undo, and Redo appear on the Quick Access toolbar. You can use Save to save your file, Undo to rollback an action you have taken, and Redo to reapply an action you have rolled back.
19. The Title Bar
Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of the document on which you are currently working. Word names the first new document you open Document1. As you open additional new documents, Word names them sequentially. When you save your document, you assign the document a new name.

20. The Ribbon
You use commands to tell Microsoft Word what to do. In Microsoft Word 2007, you use the Ribbon to issue commands. The Ribbon is located near the top of the screen, below the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays several related command groups. Within each group are related command buttons. You click buttons to issue commands or to access menus and dialog boxes. You may also find a dialog box launcher in the bottom-right corner of a group. Clicking the dialog box launcher gives you access to additional commands via a dialog box.

21. The Ruler
The ruler is found below the Ribbon.

You can use the ruler to change the format of your document quickly. If your ruler is not visible, follow the steps listed here:

1. Click the View tab to choose it.
2. Click the check box next to Ruler in the Show/Hide group. The ruler appears below the Ribbon.

22. The Text Area
Just below the ruler is a large area called the text area. You type your document in the text area. The blinking vertical line in the upper-left corner of the text area is the cursor. It marks the insertion point. As you type, your text displays at the cursor location. The horizontal line next to the cursor marks the end of the document.
23. The Vertical and Horizontal and Vertical Scroll Bars
The vertical and horizontal scroll bars enable you to move up, down, and across your window simply by dragging the icon located on the scroll bar. The vertical scroll bar is located along the right side of the screen. The horizontal scroll bar is located just above the status bar. To move up and down your document, click and drag the vertical scroll bar up and down. To move back and forth across your document, click and drag the horizontal scroll bar back and forth. You won't see a horizontal scroll bar if the width of your document fits on your screen.

24. The Status Bar
The Status bar appears at the very bottom of your window and provides such information as the current page and the number of words in your document. You can change what displays on the Status bar by right-clicking on the Status bar and selecting the options you want from the Customize Status Bar menu. You click a menu item to select it. You click it again to deselect it. A check mark next to an item means it is selected.
Understanding Document Views

In Word 2007, you can display your document in one of five views: Draft, Web Layout, Print Layout, Full Screen Reading, or Online Layout.

**Draft View**

Draft view is the most frequently used view. You use Draft view to quickly edit your document.

**Web Layout**

Web Layout view enables you to see your document as it would appear in a browser such as Internet Explorer.

**Print Layout**

The Print Layout view shows the document as it will look when it is printed.

**Reading Layout**

Reading Layout view formats your screen to make reading your document more comfortable.

**Outline View**

Outline view displays the document in outline form. You can display headings without the text. If you move a heading, the accompanying text moves with it.

You should use Draft view for these lessons. Before moving ahead, make sure you are in Draft view:
1. Click the View tab.
2. Click Draft in the Document Views group. When the Draft option is selected it appears in a contrasting color.

26. Click

During the lessons that follow, you will be asked to "click" items and to choose tabs. When asked to click:
1. Point to the item.
2. Press your left mouse button once.
If you are asked to double-click an item:
1. Point to the item.
2. Quickly press your left mouse button twice.
If you are asked to right-click:
1. Point to the item.
2. Press your right mouse button.
If you are asked to choose a tab, click the tab.

27. Understanding Nonprinting Characters

Certain characters, called nonprinting characters, do not print and will not appear in your printed document but do affect your document layout. You can elect to see these characters on the screen as you type or you can elect to have them remain invisible. For these lessons, opt to see them onscreen. This table describes most of them:

<table>
<thead>
<tr>
<th>Character</th>
<th>Denotes</th>
</tr>
</thead>
<tbody>
<tr>
<td>→</td>
<td>A tab</td>
</tr>
<tr>
<td>.</td>
<td>A space</td>
</tr>
<tr>
<td>¶</td>
<td>The end of a paragraph</td>
</tr>
</tbody>
</table>

Hidden text

To view nonprinting characters:
1. Choose the Home tab.
2. Click the Show/Hide button in the Paragraph group. The Show/Hide button appears in a contrasting color, when it is selected.

28. Create Sample Data and Select Text
If you type =rand() in your Word document and then press Enter, Word creates three paragraphs. You can use these paragraphs to practice what you learn. Throughout these lessons, you will be asked to select text. The following exercise teaches you how to create data and how to select data. You can select by using the arrow keys or by clicking and dragging. When using the arrow keys, use the up arrow to move up, the down arrow to move down, the left arrow to move left, and the right arrow to move right. When using the mouse, press the left mouse button and then drag in the direction you want to move.

29. EXERCISE 1
30. Create Sample Data
   1. Type =rand().

31. Select with the Shift and Arrow Keys
   1. Place your cursor before the word "On" in the first paragraph.
   2. Press and hold down the Shift key, which serves as an "anchor" showing where text you wish to select begins or ends.
   3. Press the right arrow key until the first line of text is highlighted.
   4. Press the down arrow key until the first paragraph is highlighted.
5. Click anywhere outside the highlighted area to remove the highlighting.

32. Select with the Mouse
1. Place your cursor before the word "You" in the second paragraph.
2. Press and hold down the left mouse button.
3. Drag the mouse until you have highlighted the second paragraph.
4. Click anywhere outside the highlighted area to remove the highlighting.

33. Place the Cursor
During the lessons, you will often be asked to place the cursor at a specific location (the insertion point) on the screen. You place the cursor by moving the cursor to the specified location and pressing the left mouse button or by using the arrow keys to move to the specified location.

34. EXERCISE 2

35. The Arrow Keys
1. Use the down arrow key to move down your document.
2. Use the right arrow key to move to the right.
3. Use the up arrow key to move up.
4. Use the left arrow key to move to the left.

Cursor
1. Move around your document by using your mouse and clicking in a variety of locations.
2. Click in a location and type. Note what happens.

36. Execute Commands with Keyboard Shortcuts
There are many methods you can use to accomplish tasks when using Word. Generally, you choose an option by clicking the option on the Ribbon. However, you can also use shortcut keys. A key name followed by a plus and a letter means to hold down the key while pressing the letter. For example, Ctrl+b means you should hold down the Ctrl key while pressing "b." A shorthand notation of the above would read as follows:
Press Ctrl+b
Typists who are slowed down by using a mouse usually prefer using keys.

37. Start a New Paragraph
When you type in Microsoft Word, you do not need to press a key to move to a new line. To start a new paragraph, press the Enter key.

38. Exit Word
You have completed Lesson One. Typically, you save your work before exiting.

39. Lesson 2: Microsoft Word 2007 Basic Features

40. Microsoft Word
41. In the first lesson of this Microsoft Word tutorial, we familiarized you with the Word window. In this lesson, you will learn how to create a Microsoft Word document.

42. Lesson 2: Microsoft Word 2007 Basic Features
Lesson 1 familiarized you with the Microsoft Word window. You are now ready to learn how to create a Word document. This lesson covers typing, using the Backspace key, using the Delete key, inserting text, bolding, underlining, and italicizing. To begin, open Microsoft Word.
43. **Type, Backspace, and Delete**

In Microsoft Word, you create documents by typing them. For example, if you want to create a report, you open Microsoft Word and then begin typing. You do not have to do anything when your text reaches the end of a line and you want to move to a new line—Microsoft Word automatically moves your text to a new line. If you want to start a new paragraph, press Enter. Microsoft Word creates a blank line to indicate the start of a new paragraph. To capitalize, hold down the Shift key while typing the letter you want to capitalize. If you make a mistake, you can delete what you typed and then type your correction.

You can use the Backspace key to delete. Each time you press the Backspace key, Microsoft Word deletes the character that precedes the insertion point. The insertion point is the point at which your mouse pointer is located. You can also delete text by using the Delete key. First, you select the text you want to delete; then you press the Delete key.

44. **EXERCISE 1**

45. **Type and Backspace**

1. Type the following sentence:
   **Joe has a very large house.**
2. Delete the word "house." Using either the arrow keys or the mouse, place the cursor between the period and the "e" in "house."
3. Press the Backspace key until the word "house" is deleted.
4. Type **boat**. The sentence should now read: "Joe has a very large boat."

46. **Delete**

Delete the word "very" from the sentence you just typed.

1. Select the word "very." You can place the cursor before the "v" in the word "very," press and hold down the Shift key, and then press the right arrow key until the word "very" is highlighted.
2. Press the Delete key. The sentence should now read: "Joe has a large boat."

47. **Insert and Overtype**

While creating your document, you may find you need to insert text—place new text between existing text. Suppose, you type the sentence, "Joe has a large boat." After typing it, you decide you want to change the sentence to "Joe has a **large** blue boat." With Microsoft Word, inserting a word, phrase, or even several paragraphs is easy. Alternatively, you may want to overtype text—replace old text with new text. For example, suppose you type the sentence, "Joe has a large **blue** boat." After typing it, you decide you want to change the sentence to "Joe has a large **gray** boat." With Microsoft Word, overtyping the word blue with the word gray is also easy. Before you attempt to insert or overtype, you should check the mode you are in—Insert or Overtype. You right-click the Status bar and then use the Customize Status Bar menu to place the Insert/Overtype button on the Status bar. You can then use the Insert/Overtype button to switch between Insert and Overtype mode. When you are in Insert mode, you can insert text. When you are in Overtype mode, you can overtype text. By default, Microsoft Word is in the Insert mode.

48. **EXERCISE 2**

49. **Placing the Insert/Overtype button on the Status bar**

1. Right-click the Status bar. The Customize Status Bar menu appears.
2. Click Overtype. The Insert/Overtype button appears on the Status bar.
3. If the word Insert appears on the Status bar, you are in Insert mode.
4. If the word Overtype appears on the Status bar, click the word Overtype and it will change to Insert, thereby changing Word to Insert mode.
50. Insert
Make sure you are in Insert mode before proceeding. You are going to insert the word "blue" between the words "large" and "boat."
1. Place the cursor after the space between the words "large" and "boat."
2. Type the word blue.
3. Press the spacebar to add a space.
4. The sentence should now read:
"Joe has a large blue boat."
51. Overtype
You can type over the current text (replace the current text with new text) in the Overtype mode. Do the following to change to the Overtype mode.
 Click "Insert" on the Status bar. The word Insert changes to Overtype.
Change the word "blue" to "gray."
1. Place the cursor before the letter "b" in "blue."
2. Type the word gray.
3. The sentence should now read:
"Joe has a large gray boat."
Note: You can overtype text without changing to Overtype mode by selecting the text you want to overtype and then typing.
52. Bold, Italicize, and Underline
When creating a document, you may need to emphasize particular words or phrases by bolding, underlining, or italicizing. Also, certain grammatical constructs require that you bold, underline, or italicize. You can bold, underline, and italicize when using Word. You also can combine these features—in other words, you can bold, underline, and italicize a single piece of text.
When you need to perform a task in Microsoft Word, you can usually choose from several methods. The exercises that follow show you how to bold, underline, or italicize using four different methods: using the launcher, the Ribbon, the Mini-toolbar/context menu, and the keyboard.
53. EXERCISE 3
Type the following exactly as shown. Remember, pressing the Enter key starts a new paragraph. Press the Enter key at the end of each of the following lines to start a new paragraph.
Launcher: Bold Italicize Underline these words. All three Regular
Ribbon: Bold Italicize Underline these words. All three Regular
Mini Toolbar: Bold Italicize Regular
Keys: Bold Italicize Underline these words. All three Regular
Your screen should look similar to the one shown here.

54. Bold with the Dialog Box Launcher

1. On the line that begins with Launcher, select the word "Bold." You can place the cursor before the letter "B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is highlighted.
2. Choose the Home tab.
3. Click the dialog box launcher in the Font group. The Font dialog box appears.
4. Click Bold in the Font Style box.  
**Note:** You can see the effect of your action in the Preview window. To remove the bold, click Regular.

5. Click OK to close the dialog box.

6. Click anywhere in the text area to remove the highlighting. You have bolded the word bold.

**Alternate Method—Bold with the Ribbon**

1. On the line that begins with "Ribbon," select the word "Bold." You can place the cursor before the letter "B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is highlighted.

2. Choose the Home tab.
3. Click the Bold button \( \textbf{B} \) in the Font group. You have bolded the word bold. 

   \textbf{Note:} To remove the bold, you can select the text and then click the Bold button again.

4. Click anywhere in the text area to remove the highlighting.

   \textbf{56. Alternate Method - Bold with the Mini Toolbar}

1. On the line that begins with "Mini Toolbar," select the word "Bold." You can place the cursor before the letter "B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is highlighted.

2. Right-click. The Mini toolbar appears.
3. Click the Bold button. You have bolded the word bold.

57. Alternate Method—Bold with Keys

1. On the line that begins with "Keys," select the word "Bold." You can place the cursor before the letter "B" in "Bold." Press the Shift key; then press the right arrow key until the entire word is highlighted.
2. Press Ctrl+b (hold down the Ctrl key while pressing b).

Note: To remove the Bold, press Ctrl+b again. You can also remove formatting by pressing Ctrl+spacebar.
3. Click anywhere in the text area to remove the highlighting.

58. Italicize with the Dialog Box Launcher

1. On the line that begins with Launcher, select the word "Italicize." You can place the cursor before the letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is highlighted.
2. Choose the Home tab.
3. Click the dialog box launcher in the Font group. The Font dialog box appears.
4. Click Italic in the Font Style box. 
   Note: You can see the effect of your selection in the Preview window. To remove the italics, click Regular in the Font Style box.
5. Click OK to close the Font dialog box.
6. Click anywhere in the text area to remove the highlighting. You have italicized the word Italicize.

**59. Alternate Method—Italicize with the Ribbon**

1. On the line that begins with "Ribbon," select the word "Italicize." You can place the cursor before the letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is highlighted.
2. Choose the Home tab.
3. Click the Italic button \( I \) on the Ribbon. You have italicized the word Italicize.
   
   Note: To remove the italics, select the text and click the Italicize button \( I \) again.
4. Click anywhere in the text area to remove the highlighting.
60. Alternate Method—Italicize with the Mini Toolbar

1. On the line that begins with "Mini Toolbar," select the word "Italicize." You can place the cursor before the letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is highlighted.
2. Right-click. The Mini toolbar appears.

   This is an underline.

   This is a words-only underline.

   This is a double underline.

   This is a thick underline.

   This is a dotted underline.

   This is a dashed underline.

   This is a dot-dash underline.

   This is a dot-dot-dash underline.

3. Click the Italic button . You have italicized the word Italicize.

61. Alternate Method—Italicize with Keys

1. On the line that begins with "Keys," select the word "Italicize." You can place the cursor before the letter "I" in "Italicize." Press the Shift key; then press the right arrow key until the entire word is highlighted.
2. Press Ctrl+i (hold down the Ctrl key while pressing i).
Note: To remove italics, press Ctrl+i again. You can also remove formatting by pressing Ctrl+spacebar.
3. Click anywhere in the text area to remove the highlighting. You have italicized the word Italicize.

62. **Underline with the Dialog Box Launcher**
You can underline when using Word. Word provides you with many types of underlines from which to choose. The following are some of the underlines that are available if you use the dialog box launcher:

```
This is an underline.
This is a words-only underline.
This is a double underline.
This is a thick underline.
This is a dotted underline.
This is a dashed underline.
This is a dot-dash underline.
This is a dot-dot-dash underline.
This is a wave underline.
```

The following illustrates underlining with the dialog box launcher:

1. On the line that begins with "Launcher," select the words "Underline these words."
2. Choose the Home tab.
3. Click the dialog box launcher in the Font group. The Font dialog box appears.
4. In the Underline Style box, click the down arrow to open the pull-down menu.
5. Click the type of underline you wish to use.
   **Note:** To remove an underline, you select None from the pull-down menu.
6. Click OK to close the dialog box. The underline you selected appears under the words.
7. Click anywhere in the text area to remove the highlighting.

### 63. Alternate Method—Underline with the Ribbon

1. On the line that begins with "Ribbon," select the words "Underline these words."
2. Choose the Home tab.
3. Click the Underline button \( \checkmark \) in the Font group. Alternatively, you can press the down arrow next to the underline button \( \checkmark \) and click to choose the type of underline you want.
   **Note:** To remove the underlining, click the Underline button \( \checkmark \) again.
4. Click anywhere in the text area to remove the highlighting.
64. Alternate Method—Underline with Keys
1. On the line that begins with "Keys," select the words "Underline these words."
2. Press Ctrl+u (hold down the Ctrl key while pressing u).
   Note: To remove the underlining, press Ctrl+u again.
3. Click anywhere in the text area to remove the highlighting.

65. All Three with the Dialog Box Launcher
1. On the line that begins with "Launcher," select the words "All three."
2. Choose the Home tab.
3. Click the dialog box launcher in the Font group. The Font dialog box appears.
4. In the Font Style box, click Bold Italic.
   Note: You can see the effect of your selection in the preview window. To turn off the Bold Italic, click Regular.
5. In the Underline box, click to open the pull-down menu. Click the type of underline you want to use.
   Note: To remove an underline, select None from the pull-down menu.
6. Click OK to close the dialog box.
7. Click anywhere in the text area to remove the highlighting.

66. Alternate Method—All Three with the Ribbon
1. On the line that begins with "Ribbon," select the words "All three."
2. Choose the Home tab.
3. Click the Bold button in the Font group.
4. Click the Italic button in the Font group.
5. Click the Underline button in the Font group.
6. Click anywhere in the text area to remove the highlighting.

67. Alternate Method—All Three with Keys
1. On the line that begins with "Keys," select the words "All three."
2. Press Ctrl+b (bold).
3. Press Ctrl+i (italicize).
4. Press Ctrl+u (underline).
   Note: You can remove formatting by highlighting the text and pressing Ctrl+spacebar.
5. Click anywhere in the text area to remove the highlighting.

68. Save a File and Close Word
You must save your documents if you wish to recall them later. You can use the Save option on the Microsoft Office menu, to save a document. You can also save a document by typing Ctrl+s. The first time you save a document, the Save As dialog box appears. Use the Save As dialog box to locate the folder in which you want to save your document and to give your document a name. After you have saved your document at least once, you can save any changes you make to your document simply by clicking the Save after you click the Microsoft Office button.
The following exercise shows you how to save the file you just created and close Word. You will name your file Lesson Two.
69. **EXERCISE 4**

70. **Save a File—Windows Vista:**

1. Click the Microsoft Office button. A menu appears.
2. Click Save. The Save As dialog box appears, if you are saving your document for the first time.
3. Use the Address bar to locate the folder in which you want to save your file.
4. Name your file by typing **Lesson Two.docx** in the File Name box.
5. Click **Save**.
6. Click the Microsoft Office button. A menu appears.
7. Click Exit Word, which is located in the bottom-right corner of the window. Word closes.

71. **Save a File—Windows XP**

1. Click the Microsoft Office button. A menu appears.
2. Click Save. The Save As dialog box appears if you are saving your document for the first time.
3. Specify the correct folder in the Save In box.
4. Name your document by typing **Lesson Two** in the File Name box.
5. Click Save.
6. Click the Microsoft Office button. A menu appears.
7. Click Exit Word, which is located in the bottom-right corner of the window. Word closes.

Every time you save your document, you overwrite the previous version of your document. For example, you create a document and save it. Later you delete several passages from the document and then save your changes. The passages from the first draft of the document no longer exist. If you want to save both the original draft of your document and the revised document, you must save the second draft of the document using a different name. To save the document using a different name, click the Microsoft Office button. A menu appears. Click Save As. The Save As dialog box appears. Use the File Name box to give your document a new name.

**72. EXERCISE 3**

**73. Close and Save—Windows Vista**

1. Click the Microsoft Office button. A menu appears.
2. Click Exit Word, which you can find in the bottom-right corner.

3. You are prompted: "Do you want to save changes to Document1?" To save your changes, click Yes. Otherwise, click No. If you click Yes, the Save As dialog box appears.
4. Move to the correct folder.
5. Name your file by typing Lesson One.doc in the File Name field.
6. Click Save. Word saves your file.

**74. Close and Save—Windows XP**
1. Click the Microsoft Office button. A menu appears.
2. Click Exit Word, which is in the bottom-right corner.
3. You will be prompted: “Do you want to save changes to Document1?” To save your changes, click Yes. Otherwise, click No. If you click Yes, the Save As dialog box appears.
4. Specify the correct folder in the Save In box.
5. Name your file by typing Lesson One.doc in the File Name field.
6. Click Save. Word saves your file.

**74.1. Creating Resume and Cover letter**
Create a cover letter and resume for a job in your area

**75. CHAPTER 7: Ms Excel**

**75.1. Introduction to Ms Excel**

MS Excel Page 1 of 40

MS EXCEL

A spreadsheet is essentially a matrix of rows and columns. Consider a sheet of paper on which horizontal and vertical lines are drawn to yield a rectangular grid. The grid namely a cell, is the result of the intersection of a row with a column. Such a structure is called a Spreadsheet.

A spreadsheet package contains electronic equivalent of a pen, an eraser and large sheet of paper with vertical and horizontal lines to give rows and columns. The cursor position uniquely shown in dark mode indicates where the pen is currently pointing. We can enter text or numbers at any position on the worksheet. We can enter a formula in a cell where we want to perform a calculation and results are to be displayed. A powerful recalculation facility jumps into action each time we update the cell contents with new data.

MS-Excel is the most powerful spreadsheet package brought by Microsoft. The three main components of this package are

- Electronic spreadsheet
Database management
Generation of Charts.
Each workbook provides 3 worksheets with facility to increase the number of sheets. Each sheet provides 256 columns and 65536 rows to work with. Though the spreadsheet packages were originally designed for accountants, they have become popular with almost everyone working with figures. Sales executives, book-keepers, officers, students, research scholars, investors bankers etc, almost any one find some form of application for it.
You will learn the following features at the end of this section.
- Starting Excel 2003
- Using Help
- Workbook Management
- Cursor Management
- Manipulating Data
- Using Formulae and Functions
- Formatting Spreadsheet
- Printing and Layout
- Creating Charts and Graphs

Starting Excel 2003
- Switch on your computer and click on the Start button at the bottom left of the screen.
- Move the mouse pointer to Programs, then across to Microsoft Excel, then click on Excel as shown in this screen.
- When you open Excel a screen similar to this will appear

Workbook Management
Task 1: Creating a new workbook
Click on File menu and then click on New.
Click Workbook and then click OK button. You will get the screen as shown below.

Task 2: Saving Workbook
Click on File menu and then click save. You will get the below screen
In the File name text box, type sample and then click Save button

Task 3: Opening an existing workbook
Click on the File menu and click on Open. The open dialog box will appear
Click on some file (Example: sample.xls), then click on Open.

Task 4: Closing your workbook
Click on File menu, then click Close to close your workbook

Cursor Management
Task 1: Moving around the worksheet
Open sample.xls workbook.
Move the cursor in your worksheet by using the arrow keys on the right-hand side of the keyboard.
When you have got lots of rows of data you can move the cursor more quickly by using the PgUp and PgDn keys to move up and down a screen at a time.
To move one screen to the right, press the Alt key and PgDn keys together.
To move one screen to the left, press the Alt and PgUp keys together.
To move further to the right, just keep pressing the right arrow key.
To move back to cell A1, press the Ctrl and Home keys together.
Pressing the Home key on its own takes you back to column A
To move to the last column(IV) press the Ctrl and right arrow keys together.

To move to last cell containing data, press Ctrl and End keys together.
To move to the last row(65,536), press Ctrl and the down arrow keys together.
You can also move the cursor with the mouse. Move the mouse pointer to the location you want. Press and release the left mouse button once when the cursor is where you want it.

Task 2: Moving to a Specified cell
Click on the Edit menu, choose Go To. You will get the below screen
Enter the destination cell reference in the Reference text box.
Click OK to move directly to the specified cell.

Data Manipulation

Task 1: Entering data
Start Excel. Click File and then New. An empty worksheet appears as shown below.

Type Expenditure in cell A1 then press down arrow key to move to cell A2.
Type Month then press the down arrow key to move to cell A3
Continue to type the data. The resulting worksheet should appear like the following screen.

Save your work by clicking File and then Save As. This dialog box appears.
Type cash in the File Name text box and then click Save button. Excel automatically adds the extension .xls to your file name.

Task 2: Editing data
Click File and then click Open.
Click cash.xls and then click Open.
Move the mouse pointer to cell D4, click and release. The cell is highlighted and 18 appears in the formula bar.
Move the mouse pointer to the formula bar and click once to the right of 18.
Use the Backspace key to delete 8, then type 4 and press Enter. Cell D4 now contains the value 14.

Task 3: Replacing cell data
Make the cell B5 active by clicking on it.
Type 200 and press Enter. The cell B5 will now contain the value 200 replacing old value (150).

Task 4: Deleting cell contents
Move to cell C5 and click to select.
Press the Delete key.
The cell becomes blank.

Task 5: Copying data
Open the cash spreadsheet.
Select the cells D3 to D5
Click Edit menu and then click Copy.
Select the cells F3 to F5.
Click Edit menu and then click Paste.
Now the cells D3 to D5 are copied into F3 to F5.

Task 6: Moving data
Open cash.xls spreadsheet.
Select the cells from B3 to B5.

Click Edit menu and then click Cut.

Select the cells G3 to G5.

Click Edit menu and then click Paste.

Task 7: Data Auto Fill

There is an easy method to fill the data in columns and rows. The data may be Numeric or dates and text.

To fill Slno by using auto fill

- Type Slno for 2 cells i.e 1,2 in the cells A1 and A2 respectively.
- Select two cells and drag the Fill Handle.

To fill dates in the cells

- Type date in the cell
- Select the cell and drag the Fill Handle.

We can customize the lists with different text data to minimize the redundancy of work.

Some of the lists are listed below:
1. Jan, Feb, Mar, Apr, May, June, July…. like months
2. Sunday, Monday, Tuesday, Wednesday, Thursday…Like week days
3. Adilabad, Anatapur, Chittor, Cuddapah… like District names
4. Ravi, Kiran, Praveen, Rama…. like employees list

To create a customized list follow the steps given below:

- Click Tools Menu, Click Options then click Custom Lists tab, Then you will find the figure given below:
- Click NEW LIST and enter the list in the List entries window
- Click Add button then click OK button then your list will be added to the Custom Lists. That list you can use as and when required to type.
- Now you can Drag the fill handle (+) to get the list automatically.

Using Formulae and Functions

Task 1: Entering a formulae

- Click File and then click New.
- Enter the data in the new worksheet as shown below
- Cell B6 should contain formula. Move the cell pointer to cell B6.
- Type =B3+B5(formulae and functions should always begin with = sign)
- Cell B6 will now contain the value 350
- Look at cell B6; you will see the result of the formula in the cell B6 rather than formula.
- Now repeat the appropriate formula for cell C6, D6.
- Save your worksheet as cash3.xls.

Task 2: Editing Formulae

- Move the cursor to the formula bar with the mouse, clicking
once.

- Make the desired changes.
- When you have finished editing the formulae, press the Enter key for the changes to take effect.

(OR)

- Edit the contents by pressing F2 key on the keyboard

Task 3: Displaying and Printing formulae

- Click Tools menu and then click Options.
- Click View tab.
- In Window options check Formulas check box. The below screen appears.

MS Excel Page 19 of 40

- Click OK button.
- To print the worksheet with formulae displayed, click File menu and click on Print Preview. If the layout is satisfactory, click on the Print button.

Task 4: Using the SUM function

- Open cash3.xls spreadsheet.
- Suppose if you want the summation of the cells B3 to B5 should appear in the cell B6, then first select the cells from B3 to B6.

MS Excel Page 20 of 40

- Click the Auto Sum icon on the toolbar.
- The result of (B3+B4+B5) will appear in the cell B6.

Task 4: Copying Formulae

- Open cash3.xls spreadsheet.
- If you want to copy the formula in the cell B6 to C6,D6,E6 then first select the cell B6.
- Move the cursor to the lower right corner of the cell B6. The cursor will change to + icon.
- Drag the cursor from B6 to E6 and release left mouse button.
- You will notice that the cells C6, D6 and E6 are updated immediately as shown below.

Task 5: Copying formulae using absolute addressing

- Create the worksheet shown below and save ABS
- If you copy the formula in the cell c2 to c3, c4, c5 you will get the incorrect result because the formula will change in the cell (C3)to B3*A10 but the value in the A10 is not defined. The reason is that we are copying relative address but not absolute address. To use absolute address move to c2 cell.
- Edit the formula to =B2+($B$2*$A$9) and press Enter key.
- Copy the formula to cells C3 to C5.

Formatting Spreadsheet

MS Excel Page 21 of 40

Task1: Increasing column width

- Open an existing worksheet(For example cash3.xls)
- Move the mouse pointer to the position(column B)shown below
in the column header. When the black cross appears, hold down the left button and drag the mouse to the right to increase the column width by the required amount.

**Task 2: Decreasing column width**
- Open cash3.xls spreadsheet.
- Move the mouse pointer to the column B. When the black cross appears, hold down the left button and drag the mouse to the left to reduce the cell width.

**Task 3: Changing width of all cells in a spreadsheet**

**MS Excel Page 23 of 40**
- Open cash3.xls spreadsheet
- Select the entire worksheet by clicking the Select All button (to the left of A1 cell) at the top left corner of the worksheet. The worksheet changes from white to black.
- Click Format menu, click Column, then click Width
- In the column width text box type 20, then click OK button. Your worksheet cells should all increase in width.
- You will get the below screen. You will notice that widths of all columns are now changes to 20

**MS Excel Page 24 of 40**
- Click the Undo button to revert to the previous cell width.

**Task 3: Inserting Columns**
- Open cash.xls spreadsheet.
- Move to cell B2 and click.
- Click Insert menu, click Columns. You will get the below screen.

**MS Excel Page 25 of 40**
- A blank column will be inserted before (to the left of column B)

**Task 4: Deleting Column contents**
- Open cash.xls spreadsheet.
- Move the mouse pointer to column E header and click to select column E
- Press Delete button. The column contents will be deleted.
- Click Undo button to revert to the previous screen.

**Task 5: Removing columns, rows, and cells completely**
- Select individual columns or rows or cells.
- Click Edit menu and click Delete

**Task 6: Inserting a row**
- When you insert a row, it is inserted above the current row, so if you want to insert a new row above row 6 (between rows 5 and 6), place the cursor on a cell in row 6 and
- Click on the Insert menu.
- Click Entire Rows insert a blank row between rows 5 and 6.

**Task 7: Deleting row contents**
- Open cash.xls spreadsheet.
- Move the mouse pointer to row 2 header and click to select the row as shown below
Press Delete to remove the contents of row.
Click the Undo button to cancel the delete operation.

Task 7: Inserting cells
Open cash.xls spreadsheet.
Select cells B2 to D4 by moving the mouse pointer to cell B2, holding down the left mouse button and dragging the mouse pointer to cell D4, then releasing the left button. The cells should be highlighted.
Click Insert menu and click Cells. This dialog box appears.
Click OK to shift the cell down.

Task 8: Changing data justification
Open cash.xls spreadsheet.
Select the cell B2 as shown below.
Here the text “Jan” by default left justified. You can modify alignment as right justified or center by clicking right justify or center the text within the cell by clicking respectively.

Task 9: Merge and Center data
Open cash.xls spreadsheet.
Select the cells A1 to H1 as shown below
Click Merge and Center button on the toolbar
You will get the below screen.

Task 10: Formatting cells
Create a new spreadsheet as shown below and save it as “marks.xls”
Now you can format the cells in column C by selecting column C by clicking on the column heading
Click Format menu and click on Cells. Click on Number.
Use the Down arrow in the Decimal Places to set to 0. Click OK.
Now repeat the formatting but this time format the cells to two decimal places.

Again, repeating the formatting operation, but this time to four decimal places.
Finally, format the cells to eight decimal places. This screen will appear.
The ###### symbols indicate that the cell is too narrow to display the data in the chosen format. However, if you increase the cell width sufficiently, the data will be displayed to eight decimal places.
Increase the width column C until the data is displayed.
Now change the formatting back to two decimal places, and reduce the column width to a suitable width.
Changing the data Orientation (Vertical, Horizontal etc.)
Excel offers three options that let you control the orientation of the text within a cell. These are Text alignment, Text orientation, and Text control.

Vertical text alignment can be any one of the following:

To display text vertically in a cell:
1. Choose Cells from the Format menu.
2. Click the Alignment Tab.
3. Specify the desired text orientation by selecting one of the orientation boxes.
4. Select the Wrap text check box, if you want Excel to wrap the text.
5. Click OK

Here are some examples of the different alignment options:

Select vertical list box and select top to align the data at the top of the cell (Eg: cell A1)
The below figure shows you different Text control options.

Printing and layout

Task 1: Previewing a printout
1. Open cash.xls spreadsheet.
2. Click on the File menu and click on Print Preview. A screen similar to this should appear.
3. Since the size of the text is very small, you can click on Zoom button, it magnifies the worksheet. Clicking on Zoom second time returns you to the original preview format.
4. Press PgDn to move through your worksheet if it is more than one page long.
5. Before printing make sure that your printer is switched on, is loaded with the appropriate paper, and is on-line.
6. If you are happy with the layout of your document, click on the Print button to obtain a printout. You should see a message on screen telling you that your file is being printer, and on which paper.

Task 2: Printing landscape
1. To select landscape mode, click on the File menu, Page Setup this screen will appear.
2. Click on the Landscape button.

Task 3: Fitting your worksheet to one page
1. In the above screen click on the Fit To: box and type: 1 page wide by 1 page tall.

Task 4: Adjusting margins
1. If you need to make changes to your worksheet before printing, click on the Close button to return to your workbook.
Task 5: Setting Header/Footer to your worksheet
 From the Page Setup dialog box, click on the Header/Footer tab to display the below screen.
 In the Header box either you select a title from the drop down menu or enter your own title. Similarly for Footer box also you can set your own title.
 Click on OK.

Task 6: Printing selected cells
 Open cash.xls spreadsheet.
 Click on the row 2 button (or any other row containing data) to highlight the entire row.

Creating charts and graphs
Task 1: Creating a Pie Chart
 Open cash.xls spreadsheet.
 Select the cells A1 to G5 as shown below
 Click on Insert menu and click Chart option. This will start the Office Assistant, to guide you through creating chart.
 Follow the instructions in each step of the Wizard. The Assistant explains each step.
 At step 3, you can specify the Chart title, X-axis title and Y-axis title separately.
 At step 4, click As object in sheet 1, then click Finish.
 Your chart is now finished. Save as cash4. Your chart is saved with the spreadsheet. This type of chart is known as an embedded chart and is saved with its worksheet.

Task 2: Creating charts when the data range is not continuous
 Open cash4.xls
 If your requirement is create a chart to show expenditure for February, then first select cells A2 to A5.
 Hold down the Ctrl key and, while holding it down, select cells C2 to C5. Your screen should be similar to this one.
 Click on the Chart Wizard and create a column chart. Your screen should look similar to this.

Task 3: Sizing a chart
 Open the cash3.xls created earlier. A screen similar to this one should appear.
 The small black markers at each corner and mid-way along
each side of the chart. These indicate that the chart is selected, and are called its selection squares.

- Click on the mid-point marker on the right-hand side, hold down the left mouse button and drag the mouse to the right about one inch (3cm), then release the mouse. The width of the chart will have increased.
- Now practice the same operation on the mid-point marker of each of the other sides of the chart.
- Now try the above, but this time on one of the four corner markers. Note that when you use these techniques, the whole chart changes in size, but it retains its original proportions.

**Task 4: Deleting Charts**

- Make sure the chart is selected (the small black markers are visible). If not, move the mouse pointer into the chart area and click and release the left mouse button once.
- Press Delete to delete the chart.

**Task 5: Moving charts and graphs**

- Move the mouse pointer into the chart area.
- Hold down the left mouse button and drag the chart to the desired position.

**Task 6: Chart headings and labels**

- While creating charts the step 3 asks for Chart heading, labels for X-axis and Y-axis. You can define your own labels or click Next button so that the default values can be accepted.
- For example Chart title is Expenditure, X-axis label is months and Y-axis label is Sales.

**Task 7: Editing chart items**

- Create the chart as shown below and save it as cash4.xls.
- Click the chart title (Expenditure). Selection markers (small black squares) will appear around the selected item.
- You can move or size the title in the same way that you can move or size a chart. Click the title box and drag it up by about one inch (3 cm), then release the mouse.
- You can format the title by selecting it, then right clicking and then selecting “Format Chart Title” from the drop down menu. You will get the below screen.

**Task 8: Adding text to a chart**

- You can select font type, font style and font size as shown above.
- Click OK.
Click View menu, click Toolbars, Drawing.
Click the Text box icon on the Drawing toolbar.
Draw a text box inside the chart area as shown below.
Click inside the text box. A flashing text cursor will appear. Now type Household Expenditure.
You can use the same procedure for any other text that you want to appear in charts.
Task 9: Adding a legend to a chart
Create a pie chart as shown below.
Display the Chart toolbar, by dropping down the view menu and clicking Toolbars, Chart. In the above figure the legend is already added.
Click inside the pie chart, then click once on the add or delete legend button on the Chart toolbar. The legend will be added if not already present and removed if it is currently present.
You can also add or delete a legend from the Chart, Chart options menu.
Task 10: Adding gridlines to a chart
Open cash3.xls worksheet and change chart type to Column chart.
Click Chart, Chart options to display this box.
Click the Gridlines tab and tick the gridlines boxes required.
Task 11: Adding data labels to a chart
Open cash3 worksheet and change chart type to pie chart.
Drop-down the chart menu and click Chart options.
Click on the Data Labels tab.
Click on Show label and percent. Your screen should look similar to this.

75.2. Excel and Financial Analysis
Use Ms Excel to design receipt, invoice and delivery note.

76. CHAPTER 8: Networking and Interent

76.1. Introduction to Internet

TELECOMMUNICATIONS AND NETWORKS

76.2. Types of networks - according to area coverage
A network occurs when two or more computers are connected together, allowing them to share data and peripherals. A computer which is not connected to any other computer (not part of a network) is known as a stand-alone computer.
There are two types of networks, these are:
- Local Area Networks (LANs)
- Wide Area Networks (WANs)
76.3. Local Area Networks (LAN) versus Wide Area Networks (WAN)
A Local area network is when a number of computers are connected together which are in close proximity to each other, such as in an office building, a school or a home.

A Wide area network is when a number of computers are connected together which span a large geographic area, such as a country or continent. WANs often connect multiple smaller networks together. Typically a WAN consists of two or more Local Area Networks.

Advantages of Local Area Networks
There are several advantages to interconnecting computers in a network. These include:
- **Sharing data and programs** such as portable storage media and load it up in each computer that required it.
- **Sharing resources**. Instead such as printers attached to each computer, you can attach the peripheral to the network and it is then linked to each station on the network.
- **Management**. As everything will be saved on the file server, rather than on the hard disks of each workstation, it means that centralised back-ups of files are available. It is also possible to manage stations remotely
- **Security**. A username and password are needed to access the network, and different levels of access can be provided to different users.
- **Flexible access**. You can use any station on the network to access your user space, you are not restricted to the use of one computer.
- **Electronic communication**. You can use e-mail and chat systems to communicate with other network users (either individually or simultaneously). With e-mail you can send electronic attachments.
- **Workgroup computing**. This is when many users are working on the same document simultaneously.

Advantages of Wide Area Networks
Wide area networks have much of the same advantages of local area networks, however some things like sharing peripherals are not practical (although possible) on a wide area network.

76.4. Types of Network Environment in an Organization
Each computer in the network is known as a **workstation** (or simply as a **station**), although one station on the network will be designated as the **file server**. This computer will store all the software that controls the network as well as any software and files that can be shared by all the computers attached to the network. Generally the file server will be a more powerful computer (faster processor, more RAM, greater backing storage capacity) than all the other computers in the network. The stations which contact the server for access to files or shared resources are known as **clients**. This network configuration is called a **client/server network**.
76.5. Internet
The internet is a global public network of resources that is openly accessible to all. It can be thought of as many smaller networks connected together.

76.6. Internet Resources (or Services)
The internet provides three main services:
- **The World Wide Web**, which gives access to remote databases through *browsing* or *searching*
- **Electronic mail**, which provides one to one (or one to many) communication and exchange of information
- **File transfer**, which makes it possible to send and receive large amounts of information.

It also provides several other services including:
- **E-commerce**
- **On-line banking**
- **On-line shopping**
- **Chat and instant messaging**
- **Web logs**
- **Bulletin boards**
- **Discussion groups**
- **Streaming video**
- **Video conferencing**

The *World Wide Web (WWW)* is a collection of information held in *multimedia* form on the internet. This information is stored at locations known as *web sites* in the form of *web pages*.

**Browser**
A *browser* is a program that allows a user to read and navigate web pages. The software also allows pages to be saved or printed. It also stores a history of recently viewed pages, and can remember web page addresses using *bookmarks*. Two of the best known browsers are Internet Explorer and Mozilla Firefox.

**Web pages**
A web page is a document that usually contains information in the form of text, images and other multimedia types

Web pages are created using a special language known as **HTML (hypertext mark-up language)**.

Each web page is stored on a web server and is identified by its unique location (address), commonly known as its **URL (uniform resource locator)**. Here is an example of a URL:

```
HTTP://www.computing.com/int2/car.html
```

```
Hyperlinks
Some web pages will contain hyperlinks. Typically hyperlinks are used to connect web pages (in the same or different sites) together. When a hyperlink is clicked, the connected web page will be retrieved from its server and loaded into your browser.

Search engines
The internet contains millions of web pages on every subject imaginable. The best way to find information is to use a search engine such as Google.

When you enter a search, you are really searching the database for words that match your entry. Advanced searches can include operators such as AND or OR to help narrow the search. The results of the search are placed on a web page that is composed of links and brief extracts for the original web page. To visit the actual page all you have to do is click on the hyperlink.

E-mail
Electronic mail (e-mail) is the exchange of computer stored messages by telecommunication. E-mail messages are usually encoded in ASCII text. However you can also send non-text files, such as graphic images and sound files as attachments.

Many e-mail systems are now web-based. This means that a user can access their e-mail from any computer that has a connection to the internet. The software used to access the e-mail may vary, but the same basic principle and functions apply. The user logs onto an e-mail server with a username and password, before access is granted. To send an e-mail message to someone you must first have their e-mail address. This is the location of the server on the internet where the person’s mailbox can be found. An example is given below.

The part before the ‘@’ symbol is the local part of the address, which is usually the username of the person on that server. The part after the ‘@’ symbol (ntlworld.com) is the domain name, which is often the name of the host e-mail service. Together they make up the e-mail address of the person to whom the message is being sent.

76.7. Internet Protocol (IP) Addressing
An Internet address or IP address is a digital code that identifies a computer (host) location on the Internet or LAN. The current standard is IP address version 4 (IPv4), which is a 32 bit long number represented in the form of four octets (eight-bit or one-byte fields) separated by dots. Each octet is displayed as a decimal number in the range of 0-255. Examples of valid IP addresses: 192.168.0.1, 205.245.172.72, 10.1.0.22, etc. An IP address on the Internet or in a local network must be unique so network packets destined for the host with that address can find it.
76.8. Data Communication Channels

Data communication channels or the transmission media is how the computers on the network are connected to one another. In a local area network, the transmission media is owned by the organisation that owns the LAN. As the stations are relatively close to one another the stations within a LAN can be connected together using **cables** or **wireless** technologies.

**Cables**

Cabling is the most common medium through which data is transmitted between stations and devices in a Local Area Network. Network cables include Ethernet and fibre cables.

**Wireless LANs**

Instead of connecting network devices with cabling, some networks are wireless. These networks use high frequency radio waves or infrared beams to communicate between the network devices. Each station on the network will have a wireless network interface card or network adapter that allows them to send and receive data wirelessly.

Wireless networks are ideal for places where it is difficult or impossible to install cables. They are also used with portable or remote workstations. Wireless networks also have some disadvantages in that they can be susceptible to electrical interference, they are slower than most cabled technologies and security can also be an issue.

Wireless technologies include **Infrared**, **Bluetooth** and **WiFi** (Wireless Fidelity)

<table>
<thead>
<tr>
<th>Transmission media</th>
<th>Twisted pair</th>
<th>Coaxial cable</th>
<th>Fibre optics</th>
<th>wireless</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bandwidth</td>
<td>10 Mbit s⁻¹</td>
<td>500 Mbit s⁻¹</td>
<td>30 Gbit s⁻¹</td>
<td>54 Mbit s⁻¹</td>
</tr>
<tr>
<td>Geographical spread</td>
<td>Small area – in a single building or a site linking buildings which are in close proximity</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Functions          | • Allows sharing of data files, applications and peripherals  
                      • Can access work from any workstation on network  
                      • Different levels of access can be granted  
                      • Can communicate using e-mail, chat etc |
Wide Area Networks

A Wide area network is when a number of computers are connected together which span a large geographic area, such as a country or continent. WANs often connect multiple smaller networks together. Typically a WAN consists of two or more Local Area Networks.

Advantages of Wide Area Networks
Wide area networks have much of the same advantages of local area networks, however some things like sharing peripherals are not practical (although possible) on a wide area network.

Transmission media
Computers connected to a wide area network are often connected through existing public networks, but they may also be connected through leased lines (permanent telephone connection between two points). The transmission media used in wide area networks they include microwave transmission, satellite links, radio and optical fibres.

Summary of WANs

<table>
<thead>
<tr>
<th>Transmission media</th>
<th>Fibre optics</th>
<th>Microwave</th>
<th>Satellite</th>
<th>Radio</th>
</tr>
</thead>
<tbody>
<tr>
<td>bandwidth</td>
<td>30 Gbit s⁻¹</td>
<td>100 Mbit s⁻¹</td>
<td>100 Mbit s⁻¹</td>
<td>2 Mbit s⁻¹</td>
</tr>
<tr>
<td>Geographical spread</td>
<td>large area – spread throughout a country or the world</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| functions          | • Allows sharing of data files, applications and peripherals  
|                     | • Can communicate using e-mail, chat and allows video conferencing  
|                     | • E-commerce  
|                     | • Entertainment |

76.9. Intranets versus Extranets

INTRANETS
1. An intranet is a network inside an organization that uses Internet technologies (such as web browsers and servers, TCP/IP network protocols, HTML hypermedia document publishing and databases, and so on) to provide an Internet-like environment within the enterprise for information sharing, communications, collaboration, and the support of business processes.
2. An intranet is protected by security measures such as passwords, encryption, and firewalls, and thus can be accessed by authorized users throughout the Internet.

Intranet applications support communications and collaboration, web publishing, business operations and management, and intranet management. These applications can be integrated
with existing IS resources and applications, and extended to customers, suppliers, and business partners to create extranets.

EXTRANETS

Extranets are network links that use Internet technologies to interconnect the intranet of a business with the intranets of its customers, suppliers, or other business partners. Companies can:

1. Establish direct private network links between themselves, or create private secure Internet links between them called virtual private networks.
2. Use the unsecured Internet as the extranet link between its intranet and consumers and others, but rely on encryption of sensitive data and its own fire wall systems to provide adequate security.

The business value of extranets is derived from several factors:

- The web browser technology of extranets makes customer and supplier access of intranet resources a lot easier and faster than previous business methods.
- Extranets enable a company to offer new kinds of interactive Web-enabled services to their business partners. Thus, extranets are another way that a business can build and strengthen strategic relationships with its customers and suppliers.
- Extranets enable and improve collaboration by a business with its customers and other business partners.
- Extranets facilitate an online, interactive product development, marketing, and customer-focused process that can bring better designed products to market faster.

## 77. Data Security

### 77.1. Data Security

### 78. CONTROLLING INFORMATION SYSTEMS

Data security and controls refers to various threats to data and the counter measures taken to ensure that data is not lost, altered illegally or accessed by unauthorized persons. Although data does not show on the balance sheet as an asset, many companies are totally reliant on the information stored on their PC’s, Laptops and Networks. Electronic data processing involves processing large volumes of data with little or no human intervention. It also concentrated in small storage media that can be easily stolen or misplaced. Computer Based Information Systems are also often connect on the Internet such that unknown persons can remotely connect to an organization's computers without been noted physically.

Here we look at some of the issues to consider when reviewing the security of your computer systems, and some of the compliance issues surrounding data security and data protection.

### 78.1. Threats to data

As earlier identified due to the nature of electronic data it can face 3 types of threats;
- Loss of data (system unavailability): Possibly due to theft, corruption by virus or system malfunction, power failure, Internet disconnection, etc.
- Unauthorized alteration or accidental alteration (loss of integrity): Such data although may not be said to be lost, the contents are no longer reliable. So the data has lost its integrity.
- Unauthorized access (loss of confidentiality): When data is accessed by unauthorized users such as eavesdroppers, hackers and industrial espionage, the company may lose the benefit of its trade secrets. Many times employees are source of this threat and so persons should be limited to the data that concern the alone and audit trails can be used to track what employees do in their computer systems.

**78.2. Administrative controls versus system controls**

Administrative controls refers to data security controls that are implemented through the organization administrative framework. It involves policies and procedures about processing data; such as segregation of duties, insurance, fire and anti-burglary, authorization of processing, work ethics, and any other practices that enhance safety and security of an information system.

System controls on the other refers to data security control measures that are in-built into the computer system to ensure correct input, correct processing, correct output and security of data stored. Such controls become a part of the computer system design.

**78.3. Physical versus logical controls**

The controls needed for information systems performance and security, the legal and ethical implications of the control of computer crime and other societal impacts of information systems.

Although data does not show on the balance sheet as an asset, many companies are totally reliant on the information stored on their PC’s, Laptops and Networks.
Here we look at some of the issues to consider when reviewing the security of your computer systems, and some of the compliance issues surrounding data security and data protection.

**78.4. Examples of Data Security Controls**

**Passwords**

Passwords are one of the measures which can be used to implement access controls.
However, to be at all effective they should:
- be relatively long (i.e. 8 characters or more)
- contain a mixture of alpha, numeric and other characters (such as &^“)
- not be the same for all applications
- be changed regularly
- be removed or changed when an employee leaves.

**Data backup and restore**

Data backup is an essential process for security and needs to be undertaken on a regular basis. There are a number of points to consider.
**Data file locations**
In a network environment some data files might be stored on the server and other data files stored on local drives. In which case separate backups may be required for both the server and one or more PC’s.

**Backup strategy**
There is likely to be a need for two parallel backup procedures; one to cover a complete systems backup and another to cover the backing up of individual applications’ data files.

**Complete systems backup**
On a network some form of server backup software should be used to take a complete copy of the network drive(s). This can normally be set to run overnight. However, someone will need to be given responsibility for these procedures.

Key areas to consider include: training in how to use the backup software, alter backup schedules and change backup file criteria.

The person responsible needs to be able to: adapt the backup criteria as new applications are added interpret backup logs and react to any errors notified restore data from backup media maintain a regular log of backups and where these are stored.

Finally, be aware that some backup utilities only take a mirror image of the hard disc. In this case, the whole of the hard disc has to be restored even if there is a problem with just one file or just one folder.

**Applications backup**
Many accounting and payroll packages have their own backup routines. It is a good idea to use these (as well as full server backup) on a regular basis, and always just before period end, or pay period end, update routines.

**Local PCs**
Remember that some users will have applications data files exclusively on their local drives (such as payroll data for example) and these will all require their own regular backup regime.

**Backup media**
There are about half a dozen different types of backup media available – from the writable CD capable of storing up to 1gb, through the DVD reader/writer (5gb) up to the mighty external hard drives (1000gb). Most server backups will use either use tape cartridges or CD/DVD reader/writers. For more temporary forms of backup, a USB memory stick/pen (1gb) might be considered.

**Backup frequency**
A cycle of backups should be retained for a period of time (probably going back at least 12 months – but see Backup retention below). Overwriting the same backup disc/tape/cd/dvd day after day is not advised.

**Backup retention**
Backups should be stored in a variety of locations. Obviously, the safest place is off-site.
Physical backup media can be stored in a separate location, whilst some firms may rent disc space on a service provider’s server, to backup files to.
Issues such as how long certain type of records, accounting records for example, need to be kept for, should be borne in mind.
Backup media degradation/decomposition
Backup media degrades and the data decomposes over a period of time. DVD’s are particularly sensitive to light (i.e. they are photosensitive) for example, so ensure that they are stored in a dark environment. RW media is noted as being particularly prone to degradation, and should not be relied upon for long-term storage.
Backups should be checked on a regular basis for signs of digital decomposition.

Restoring data
As with backup, there are a number of issues to consider.

Total systems restore. This can be a complex procedure in a network environment and may require specialist network engineers to provide assistance.

Application restore. We recommended above (see Applications backup) a separate cycle of backups to cover individual applications. If it is necessary to restore the whole application from these backups, then the restore utility within the package concerned needs to be used and the correct backup media loaded.

Individual data file(s) restore. These are generally less complex, but nevertheless care is needed. If the required data files are on the server backup then the restore utility will need to be used, the correct backup media loaded and the file or files to be restored identified.

Virus/Spam protection
The prevalence of e-mail viruses and unsolicited spam means that software is required to filter these items out of the system. This software will require regular updating, along with all relevant on-going software security patches that need to be applied to the operating and applications software. Additional network security in the form of firewall software is also required to protect the network from unauthorised access and potential network attacks.

Employees
All employees should know and understand the firms’ security procedures and the consequences of abusing these. You might wish to refer to our factsheet which sets out a model internet and e-mail access policy. Staff dealing with personal data also require training in the principles of data protection and good information handling practices.

Compliance issues
Most businesses process personal data to a greater or lesser degree. If this is the case, then notification under the Data Protection Act is required. That will then mean on-going compliance with the principles of information handling and information security. We can help you with this process to ensure compliance.

Control and Management Issues
Transaction processing systems are the backbone of any organization’s information systems.

Business Resumption Planning
• It is the process of anticipating and providing for disasters. A disaster can be a flood,
fire, earthquake, intentional damage, labor unrest or erasure of an important file.

- Focus on maintaining the integrity of the corporation information and keeping the information system running until normal operations can be resumed.
- Identify potential problems and prepare for the disaster.

**Disaster Recovery**

- The implementation of the business resumption plan.
- The primary tools are backups for hardware, software, databases, telecommunication, and personnel.
- Keep a backup copy of software and database to a remote location in a safe, secure, fireproof, and temperature and humidity controlled environment.
- Always train backup personnel in case employees leave the company.

**Transaction Processing System Audit**

- Auditing a TPS system, is an attempt to answer three basic questions:
- Does the system meet the business need for which it is developed?
- What procedures and controls have been established?
- Are the procedures and controls being properly used?
- An internal audit is conducted by employees of the organization and an external audit is conducted by an outside firm.
- The auditors inspects all programs, documents, control techniques, the disaster plan, insurance protection, fire protection, and other system management concerns such as efficiency and effectiveness of the disk and tape library.
- The audit trail allows the auditors to trace any out from the computer system back to its source documents.